
A

E

I

M

Q

U

C

G

K

O

S

W

B

F

J

N

R

V

D

H

L

P

T

X

Y

Z

- 52 -

- Th e Complete Dictionary of Photography - 

DPOF (Digital Print Order Format)
A facility available on some digital cameras that enables users to mark the 
images from which they wish to have prints made.

D-SLR (digital single lens reflex)
See single-lens refl ex.

DT
A Sony lens with a smaller image circle, designed for use on crop-factor 
cameras.

Duotone
A duotone image is one made from two inks (usually black and another 
colour), and is often used in printed books to increase the tonal range of 
an image. It’s also used by some fi ne-art photographers to add subtle col-
our to black-and-white photographs. A similar appearance can be achieved 
in Photoshop by converting a colour image to greyscale, then choosing 
Image > Mode > Duotone.

DX
Tokina’s and Nikon’s way of marking lenses that are only suitable for crop-fac-
tor (or APS-C) digital SLRs.

Dynamic range
A term used to describe the range between the lightest and darkest points 
in a photograph. Th e range that can be recorded by a digital camera is 
relatively small compared with the range that the human eye can perceive.

E

Eastman, George
George Eastman (1854-1932) was an American entrepreneur and philan-
thropist. He patented the fi rst paper negative roll fi lm in 1884 before es-
tablishing Eastman Kodak in 1892, which went on to become one of the 
world’s largest photographic companies. Th e popular Kodak ‘Brownie’ 
series was launched in 1900, with the famous slogan, ‘You push the but-
ton, we do the rest’.

E

D
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(QÉ°üàNG) á«ªbôdG Qƒ°üdG áYÉÑW ôeCG

 É¡àYÉÑ£H ÖZôj »àdG Qƒ°üdG º``°Sh Ωóîà``°ùª∏d í«àoJh ,á«ªbôdG äGÒeÉμdG ¢†©H ‘ óLƒJ Iõ«e »g

.É k≤M’

 (á«aGôàM’G äGô«eÉμdG) IOôØªdG á°Só©dG äGP á°ùcÉ©dG á«ªbôdG äGô«eÉμdG

(QÉ°üàNG)

.single-lens reflex :IOÉe ô¶fG

(QÉ°üàNG) »J …O

 äGP äGÒ``eÉμ∏d á°ü°üîŸG É¡JÉ``°SóY ≈``dEG IQÉ``°TEÓd Sony Êƒ``°S ácô``°T ¬eóîà``°ùJ …òdG õ``eôdG

.(APS-C) ´ƒ£≤ŸG QÉWE’G

»FÉæãdG »fƒ∏dG §ªædG

 §≤a Úfƒd øe lQÉÑMCG É¡«a âeóîà``°SG »àdG IQƒ°üdG »gh ,¿ƒ∏dG á«FÉæK IQƒ°üdG ≈dEG Ò``°û oj í∏£°üe

 IOÉjõd á``YƒÑ£ŸG ÖàμdG ‘ Qƒ``°üdG √òg Ωóîà``°ùJ Ée É kÑdÉZh ,(ô``NBG É kfƒdh Oƒ``°SC’G ¿ƒ``μJ É``e kIOÉ``Y)

 ±ó¡H π«ª÷G ‘Gô``ZƒJƒØdG øØdG ´Gƒ``fCG øe É kYƒf É``¡àØ°üH ∂dòc Ωóîà``°ù oJh ,Qƒ°ü∏d Êƒ``∏dG ió``ŸG

 ÒKCÉàdG Gòg ≈∏Y ∫ƒ°ü◊G øμÁ .(Oƒ``°SC’Gh ¢†«HC’G) ¿ƒ∏dG ájOÉMCG Qƒ°üdG ‘ á«£ªædG øY OÉ©àH’G

 ¿ƒ∏dG êQóJ ≈dEG IQƒ°üdG π``jƒ– ∫ÓN øe ,Üƒ``°TƒJƒØdG èeÉfÈH É¡à÷É©e óæY á``«ªbôdG Qƒ``°üdG ‘

Image>Mode>Duotone :QÉ«àNG ºK øeh ,greyscale …OÉeôdG

(QÉ°üàNG) ¢ùcEG …O

 Éª¡JÉ``°SóY ≈dEG IQÉ``°TEÓd Nikon ¿ƒμjÉfh Tokina Éæ«cƒJ »àcô``°T øe πc ¬eóîà``°ùJ …òdG õeôdG

.(APS-C) ´ƒ£≤ŸG QÉWE’G äGP D-SLRs IOôØŸG á°Só©dG äGP á°ùcÉ©dG äGÒeÉμ∏d á°ü°üîŸG

§°ûædG ¥É£ædG - »μ«eÉæjódG ióªdG

 .É¡«a káæc oO ÌcC’G á£≤ædGh ,IQƒ``°üdG ‘ kIAÉ°VEG ÌcC’G á£≤ædG ÚH ióŸG ∞°Uƒd Ωóîà``°ù oj í``∏£°ü oe

 ióŸÉH áfQÉ≤ŸÉH É v«Ñ``°ùf É kØ«©°V tó``© oj á«ªbôdG äGÒ``eÉμ∏d »μ«eÉæjódG ió``ŸG ¿CG ô``còdÉH ô``jó÷G ø``e

.ájô°ûÑdG Ú©∏d »μ«eÉæjódG

êQƒL ,¿Éªà°ùjEG

 º∏«a áaÉØod ∫hCG ´ÎNG .…ÒÿG πª©dG ‘ §°TÉfh »μjôeCG ∫hÉ≤e (Ω1932-1854) ¿Éªà°ùjEG êQƒL

 »àdG ,Ω1892 ΩÉY ‘ Eastman Kodak ∑GOƒc ¿Éªà``°ùjEG ácô``°T ¢``ù°SDƒj ¿CG πÑb Ω1884 ΩÉY ‘

 â≤∏WCG Ω1900 ΩÉY ‘ .⁄É©dG ‘ ‘GôZƒJƒØdG ôjƒ°üàdG áYÉæ°U äÉcô°T ÈcCG ióMEG É k≤M’ âëÑ°UCG

( Ò¡°ûdG QÉ©°ûdG â∏ªMh ,G kÒÑc É kLGhQ âb’ »àdG (Brownie) (ÊhGôH) É¡JGÒeÉc á°ù∏°S ácô°ûdG

.(You push the button, we do the rest -Éæ«∏Y »bÉÑdGh ,∂«∏Y QõdG ô≤f
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ED
A lens featuring Extra-low Dispersion glass in one or more of its elements, 
to help correct chromatic aberration. Th is abbreviation is used by Nikon, 
Panasonic, Olympus and others.

Edgerton, Harold Eugene
Harold Eugene Edgerton (1903-1990) was a professor of electrical engi-
neering at Massachusetts Institute of Technology, who conducted innova-
tive experiments with high-speed fl ash photography. He developed a fl ash 
tube that fi red for one-millionth of a second, recording for the fi rst time 
subjects such as a bullet piercing an apple.

EF
Stands for Electro Focus. Th is is the name of the lens mount Canon intro-
duced on its fi rst autofocus SLR cameras in 1987. EF lenses can be used 
on all Canon SLRs.

Effects filter
See fi lter.

EFL (effective focal length)
A measure for comparing the angle of view and magnifi cation of diff erent 
lenses and lens settings, whatever the size of imaging chip being used. Th e 
actual focal length is converted to the equivalent focal length that would 
give the same angle of view on a camera using 35mm. See focal length.

EF-S
Stands for Electro Focus Short back focus, a lens mount introduced by 
Canon in 2003. EF-S lenses have a small image circle so they are only 
suitable for use on crop-factor SLRs. A modifi ed mount means that they 
can’t physically be fi tted onto incompatible (i.e. full-frame) Canon mod-
els.

EX
Sigma’s designation for its premium lens range.

Element
An individual optical lens. Most photographic lenses are constructed using 
a number of lens elements, placed parallel to each other along a single axis. 
Some are placed together in groups.

E
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 - ‘GôZƒJƒØdG ôjƒ°üàdG äÉë∏£°üe ¢SƒeÉb -

(QÉ°üàNG) …O …EG

 ¢``SƒÑª«dhCGh Panasonic ∂«fƒ``°SÉfÉHh Nikon ¿ƒ``μjÉf äÉcô``°T ø``e πc ¬eóîà``°ùJ …ò``dG õ``eôdG

 G vóL ¢†Øîæe âà``°ûJ iƒà``°ùe äGP á``jô°üH ô``°UÉæ©H IO shõ` òŸG É¡JÉ``°SóY ≈``dEG IQÉ``°TEÓd Olympus
 .chromatic aberration Êƒ∏dG ≠jõdG IôgÉX øe ó◊G ‘ ó«ØoJ »àdG ,Extra-low Dispersion

ø«Lƒj ódhQÉg ,¿ƒJô«LOEG

 ¢``ùà°Sƒ°ûJÉ°SÉe ó¡©Ã á«FÉHô¡μdG á``°Sóæ¡dG PÉà``°SCG (Ω1990-1903) ¿ƒ``JÒLOEG Ú``Lƒj ó``dhQÉg

 øeõdG äGP ¢``TÓØdG äÉ°†eh ΩGóîà``°SÉH ôjƒ°üàdG ∫É› ‘ á«YGóHEG ÜQÉ``Œ òØf ó``b ¿Éc ,»``æ≤àdG

 ,á«fÉãdG øe AõL ¿ƒ«∏e øe óMGh Aõ÷ ΩhóJ á°†eh AÉ£YEG ≈∏Y G kQOÉb É k°TÓa ´ÎNGh .G vóL Ò°ü≤dG

.áMÉØàdG º°ùL ¥ÎîJ »gh á°UÉ°UôdG ôjƒ°üJ ¬H ´É£à°SGh

(QÉ°üàNG) ±EG …EG

 É¡JGÒeÉc ™«ªL ≈∏Y πª©J ¿CG øμÁ »àdG É¡JÉ°SóY ≈dEG IQÉ°TEÓd ¿ƒfÉc ácô°T ¬eóîà°ùJ …òdG õeôdG

 QÉWE’G hCG Full Frame πeÉμdG QÉWE’G ´ƒf øe âfÉc AGƒ°S) D-SLRs IOôØŸG á°Só©dG äGP á°ùcÉ©dG

 ≈dEG ¿Éaô◊G Ò``°û ojh ,Ω1987 ΩÉY ‘ ´ƒ``ædG Gòg øe á``°SóY ∫hCG â``éàfCG ó``bh .(APS-C ´ƒ``£≤ŸG

 .ÊhÎμdE’G õ«cÎdG »æ©J »àdG Electro Focus IQÉÑY

äGôKDƒªdG ôà∏a – äGôKDƒªdG í°Tôe

.filter :IOÉe ô¶fG

(QÉ°üàNG) ∫É©ØdG …QDƒÑdG ó©ÑdG

 ,ÒÑμàdG ≈∏Y É¡JQóbh ,ÉgôaƒJ »àdG ájDhôdG ájhGR å«M øe äÉ``°Só©dG ÚH áfQÉ≤ª∏d Ωóîà``°ù oj ¢``SÉ«b

 ,(APS-C ´ƒ£≤e ô©°û oe hCG ,Full Frame πeÉc ô©°û oe äGP) É¡©e áeóîà°ùŸG GÒeÉμdG âfÉc Éª¡e

 áª«≤dG ≈``dEG á``°Só©∏d …QDƒÑdG ó©ÑdG πjƒ– …ô``éj ,´ƒ£≤e ô©``°û oe äGP GÒ``eÉc ΩGóîà``°SG ∫É``M »``Øa

 .πeÉc ô©°û oe äGP GÒeÉc ≈∏Y É¡``°ùØf á``°Só©dG Ö«côJ óæY É¡``°ùØf ájDhôdG ájhGR »£©oJ »àdG IôXÉæŸG

.focal length :IOÉe ô¶fG

(QÉ°üàNG) ¢SEG – ±EG …EG

 äGP äGÒeÉμ∏d á°ü°üîŸG É¡JÉ``°SóY ≈dEG IQÉ``°TEÓd Canon ¿ƒfÉc ácô``°T ¬eóîà``°ùJ …òdG õeôdG

 Ò``°ûJh .Ω2003 ΩÉ©dG ‘ ´ƒædG Gò``g øe á``°SóY ∫hCG âéàfoCG .(APS-C) G kô``°üM ´ƒ``£≤ŸG QÉ``WE’G

.Ò°ü≤dG ÊhÎμdE’G õ«cÎdG »æ©Jh ,Electro Focus Short äÉª∏μdG πFGhCG ≈dEG ±ôMC’G

(QÉ°üàNG) ¢ùcEG …EG

.IôNÉØdG É¡JÉ°SóY ≈dEG IQÉ°TEÓd Sigma Éªé«°S ácô°T ¬eóîà°ùJ …òdG õeôdG

á«°SóY IóMh – …ô°üH ô°üæY

 AÉæH øª°V IOô``Øe á«``°SóY IóMh ≈dEG í∏£°üŸG Gòg Ò``°û oj ,äGÒeÉμdG äÉ``°SóY øY å``jó◊G ó``æY

 É k©°VƒJ á©°VƒàŸG á«``°Só©dG äGóMƒdG øe OóY øe äGÒeÉμdG äÉ``°SóY º¶©e ∞dCÉàJ å«M ,á``°Só©dG

.äÉYƒª› øª°V É kÑJôe á«°Só©dG äGóMƒdG √òg ¢†©H ¿ƒμjh ,óMGh Qƒfi ∫ƒW ≈∏Y É kjRGƒàe
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Enlarger
A projector used in a traditional wet darkroom. Negatives are placed in the 
carrier, and a light inside the enlarger head projects the magnifi ed image 
onto a sheet of photographic paper on the baseboard. When the exposure 
is complete, the photograph is developed and fi xed.

Environmental portrait
A portrait shot in a subject’s home or work environment in such a way that 
it gives an insight into the subject’s character. Th e American photographer 
Arnold Newman (1918-2006) is considered the father of environmental 
portraiture.

EV (exposure value)
Th e scale used to denote the exposure required without the need to specify 
either shutter speed or aperture. A particular EV setting has its own set 
pairs of possible shutter speed and aperture. Exposure values are often 
quoted in combination with an ISO speed to denote a specifi c light level.

Evaluative metering
A metering system used on many cameras, in which light readings are 
taken from a number of diff erent areas, or zones, across the image. Th ese 
readings are then compared to data programmed into the camera, so it can 
work out an appropriate exposure setting. Information from the multi-
point autofocus system is also used, to ascertain the likely position of the 
subject. Th is ‘intelligent’ metering system can avoid many of the failings of 
simpler systems. However, it’s impossible to second-guess, so it can be 
diffi  cult to predict the occasions where it will get the exposure wrong. It’s 
also known as matrix metering.

EVF (electronic viewfinder)
An eye-level LCD screen, as found on hybrid cameras, bridge cameras and 
camcorders. Th e image seen by the lens is electronically projected onto the 
screen.

EVIL (electronic viewfinder, interchangeable lens)
A type of hybrid camera that combines features of a traditional SLR with 
those of a compact camera. Unlike a digital SLR, this type of camera has 
an electronic rather than optical viewfi nder. See compact system camera.

E
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 - ‘GôZƒJƒØdG ôjƒ°üàdG äÉë∏£°üe ¢SƒeÉb -

ôuÑμ oe

.ÉgÒ¡¶Jh ΩÓaC’G ¢†«ª– ¥É«°S ‘ ájó«∏≤àdG ¢†«ªëàdG ±ôZ ‘ Ωóîà°ùoj ¢VôY RÉ¡L

»£«ëªdG ¬jôJQƒÑdG / »Ä«ÑdG ¬jôJQƒÑdG / »Ä«ÑdG ¢UÉî°TC’G ôjƒ°üJ

 AÉ≤dEG ‘ ó«Øj É``e ƒgh ,¬æª°V ¬∏ªY ∫hGõj hCG ¬``«a ¢``û«©j …òdG …OÉ©dG ¿ÉμŸG ‘ É``e ¢üî``°T ô``jƒ°üJ

-1918) Arnold Newman ¿Éeƒ«f ódƒfQCG »μjôeC’G Qƒ°üoŸG ó©oj .á«°üî``°ûdG ¬JÉª``°S ≈∏Y Iô¶f

.ôjƒ°üàdG øe ´ƒædG Gò¡d ¢ù°SDƒŸG (Ω2006

(QÉ°üàNG) ¢†jô©àdG áª«b

 áëàa hCG ≥dÉZ áYô``°S ójó– ≈dEG áLÉ◊G ¿hO Ö``°SÉæŸG ¢†jô©àdG ≈dEG IQÉ``°TE’G ‘ Ωóîà``°ù oj §£ ofl

 áYô°S øe πμd á∏ªàëŸG º«≤dG øe kÉLGhRCG äÉ°†jô©àdG §£fl ≈∏Y áª«b πc ∂∏à“ .Úàæ«©e á°SóY

 á«¨H ∂dPh ,¢†jô©J áª«b πc ™e hõjB’G á«``°SÉ°ùM ≈dEG É k°†jCG QÉ``°û oj Ée É kÑdÉZh .á``°Só©dG áëàah ≥dÉ¨dG

.Oófi IAÉ°VEG iƒà°ùe ≈dEG ∫ƒ°UƒdG

…ôjó≤àdG ó¡°ûªdG IAÉ°VEG ¢SÉ«b ΩÉ¶f

 πãeC’G ¢†jô©àdG ≈``dEG ∫ƒ°UƒdG ≈dEG ±ó``¡j ,á«ªbôdG äGÒeÉμdG ø``e ójóY ‘ Ωóîà``°ù oj ¢``SÉ«b ΩÉ¶f

 ¿QÉ≤oJh ,ó¡``°ûŸG OGóàeG ≈∏Y ≥``WÉæe hCG •É≤f Ió``Y ‘ IAÉ°VE’G á``«ªc ΩÉ¶ædG CGô``≤j å``«M ,IQƒ``°ü∏d

 ¢†jô©J äGOGóYEG Égó©H GÒeÉμdG ìÎ≤àd ,GÒeÉμdG øª°V É k≤Ñ°ùe á›ÈŸG äÉfÉ«ÑdÉH äGAGô≤dG √òg

 Ö°ùfC’G ™bƒŸG øe ócCÉà∏d IOó©àŸG á«FÉ≤∏àdG õ«cÎdG •É≤f øe IPƒNCÉŸG äÉeƒ∏©ŸG Ωóîà°ùoJh .áÑ°SÉæe

 áª¶fCG AÉ£NCG øe ó``jóY ÖtæŒ Gòg »còdG ¢``SÉ«≤dG ΩÉ¶f ∫ÓN øe øμÁ .√ô``jƒ°üJ OGô``oŸG º``°ùé∏d

.matrix metering IAÉ°VE’G ¢SÉ«≤d áaƒØ°üŸG ΩÉ¶f º°SÉH É k°†jCG ±ô©oj .áWÉ°ùH ÌcC’G ¢SÉ«≤dG

(QÉ°üàNG) »fhôàμdE’G ájDhôdG QÉ¶æe

 á«aGÎM’G äGÒeÉμdG ‘ Ωóîà°ùoJ Ú©dG iƒà``°ùe ≈∏Y IÒ¨°U LCD πFÉ°S ∫Éà``°ùjôc ¢VôY á``°TÉ°T

 äGÒeÉμdGh ,(hybrid cameras áæ«é¡dÉH É k°†jCG ≈ª°ùoJ »àdG) mirrorless cameras IBGôŸG áÁóY

 IQƒ``°üdG ¢``V nô©oJ å``«M .camcorders ƒ``jó«ØdG äGÒ``eÉch ,bridge cameras á``«aGÎM’G ¬Ñ``°T

.IÒ¨°üdG á°TÉ°ûdG √òg ≈∏Y kIô°TÉÑe á°Só©dG øe á£≤à∏ŸG

πjóÑà∏d á∏HÉ≤dG á°Só©dG äGP IBGôªdG áªjóY Gô«eÉμdG

mirrorless interchangeable- πjóÑà∏d á∏HÉ≤dG á``°Só©dG äGP IBGôŸG áÁóY äGÒeÉμ∏d ôNBG º``°SG

 ¢†©H ÚH ™``ªŒ »àdG hybrid cameras á``æ«é¡dG äGÒ``eÉμdG ´Gƒ``fCG ø``e ´ƒ``f »``gh ,lens camera

 á›óoŸG Ö«÷G äGÒ``eÉc äGõ«e ¢†©Hh SLRs IOô``ØŸG á``°Só©dG äGP á``°ùcÉ©dG äGÒeÉμdG äGõ``«e

 ø``e ´ƒ``ædG Gò``g ¿EÉ``a ,IOô``ØŸG á``°Só©dG äGP á``°ùcÉ©dG äGÒ``eÉμdG ±Ó``îHh .compact camera

 compact camera :IOÉ``e ô``¶fG .É vjô°üH ¢``ù«dh ÊhÎμdEG á``jDhQ QÉ¶æÃ G kO shõ``e ¿ƒ``μj äGÒ``eÉμdG

.system
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- Th e Complete Dictionary of Photography - 

EXIF (exchangeable image file)
Camera settings recorded by many digital cameras as part of the image fi le. 
Th is data automatically notes a wide range of information about the pic-
ture, including the date and time it was recorded, aperture, shutter speed, 
model of camera, whether fl ash was used, number of pixels used, metering 
mode, exposure mode, exposure compensation used and zoom setting. 
Th e information can then subsequently be read by suitable software. To 
access this information in Photoshop and Elements, go to File > File Info.

Exposure
Th e total amount of light used to create an image. Th e term is also used to 
describe a single shutter cycle, that is, the process of the camera’s shutter 
opening, closing and resetting.

Exposure compensation
A control for manually overriding the built-in exposure meter of a camera 
to provide more or less light to the sensor.

Extension tube
An accessory used in macro and close-up photography that fi ts between 
the D-SLR body and the lens. Th e extra extension between the lens and 
sensor enables the lens to focus closer and to provide a higher image mag-
nifi cation than would otherwise be possible. Extension tubes are usually 
sold in sets of three, and are used singly or in combination to provide a 
total of seven diff erent magnifi cations.

Eyedropper
A Photoshop tool used to sample the colour of an area, typically changing 
the foreground colour to the same shade. It can also be used in some ad-
justment tools for setting exposure or colour balance, by clicking a particu-
lar area of tone as a reference point.

Eye relief
A measurement of the optimum viewing distance between the photogra-
pher’s eye and the camera’s viewfi nder.

Eyepiece correction
See dioptric correction.
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 - ‘GôZƒJƒØdG ôjƒ°üàdG äÉë∏£°üe ¢SƒeÉb -

(QÉ°üàNG) ± põcEG – πjóÑà∏d πHÉ≤dG IQƒ°üdG ∞∏e

 .á«∏°UC’G IQƒ°üdG ∞∏Ã äÉeƒ∏©ŸG √òg ≥ë∏oJh ,áæ«©e IQƒ°üH á°UÉÿG GÒ``eÉμdG äGOGóYEG äÉ``eƒ∏©e

 ,(≥``dÉ¨dG áYô``°Sh á``°Só©dG á``ëàØc) ¢``†jô©àdG äGOGó``YEG πé``°ù oJ äGÒ``eÉμdG ø``e G kó``jóY ¿EG å``«M

 Ωóîoà°SG GPEGh ,IQƒ°üdG •É≤àdG ïjQÉJh ,Ωóîà°ùŸG º°SGh ,(πjOƒŸG ºbQh É¡Yƒf) GÒeÉμdG äÉeƒ∏©eh

 É k≤M’ äÉeƒ∏©ŸG √òg ¢VôY øμÁ .IQƒ°üdG ∞∏Ã É¡≤ë∏oJ ºK ,iôNCG IójóY äÉeƒ∏©eh ,’ hCG ¢TÓØdG

 ≥jôW øY äÉeƒ∏©ŸG √òg ¢VôY øμÁ Üƒ``°TƒJƒa »HhOCG èeÉfôH ‘ .Ö``°SÉæŸG èeÉfÈdG ΩGóîà``°SÉH

.File> File Info ôeC’G

¢†jô©àdG

 πc ≈dEG IQÉ``°TEÓd É k°†jCG í∏£°üŸG Gòg Ωóîà``°ù ojh .IQƒ°üdG êÉàfE’ áeóîà``°ùŸG Aƒ°†dG á``«ªc ‹É``ªLEG

.shutter ≥dÉ¨∏d ¥ÓZEGh íàa á«∏ªY πc hCG ,GÒeÉμdÉH §≤à∏ oe (IQƒ°U) QÉWEG

¢†jô©àdG á°VhÉ©e

 ´É°VhC’G ‘ IQƒ°üdG IAÉ``°VEG §Ñ°†d GÒeÉμdG ¬eóîà``°ùJ …òdG ¢†jô©à∏d á«°VGÎa’G á``ª«≤dG π``jó©J

 ¢SÉ«≤e ≈∏Y á«°VGÎa’G áª«≤dG ¿ƒμJ å«M ,(≥dÉ¨dG áYô°S ájƒdhCG hCG á°Só©dG áëàa ájƒdhCG) á«FÉ≤∏àdG

.ÌcCG hCG πbCG áª«b ≈dEG É¡aôëH ¢†jô©àdG á°VhÉ©e ¿ƒμJh ,G kôØ°U ¢†jô©àdG

ádÉ£à°S’G ÜƒÑfCG

 ƒgh ,D-SLRs IOôØŸG á°Só©dG äGP á``°ùcÉ©dG á«ªbôdG äGÒeÉμdG ™e Ωóîà``°ù oJ »àdG äÉ≤ë∏ŸG óMCG

 ø uμ oÁ å«M ,(Üôb øY ôjƒ°üàdG) hôcÉŸG ôjƒ°üJ ‘ ó«Øojh ,GÒeÉμdGh á°Só©dG ÚH âsÑã oj ÆQÉa ÜƒÑfCG

 OGôŸG º``°ùé∏d ÈcCG Qƒ°U ≈∏Y ∫ƒ°ü◊G ºK øe óYÉ``°ù ojh ,ÜôbCG •É≤f ‘ õ«cÎdG øe á``°Só©dG ∂dP

 hCG É vjOGôaEG Ωóîà``°ù oJh ,Ö«HÉfCG áKÓK øe áØdDƒe ká``Yƒª› ádÉ£à``°S’G Ö«HÉfCG ´ÉÑ oJ Ée É`` kÑdÉZ .√ô``jƒ°üJ

.¢†©ÑdG ≈dEG É¡°†©H (G nAõ oL hCG vÓ oc) É¡ª°†H

¿ƒ∏dG QÉ«àNG IGOCG – IQÉ s£≤dG

 É kfƒd √OÉ``ªàYGh ,IQƒ°üdG ‘ Oó``fi ¿ƒd AÉ≤àf’ Ωóîà``°ù oJh ,Üƒ``°TƒJƒa »``HhOCG è``eÉfôH äGhOCG ió``MEG

 ¿GRƒJ hCG ¢†jô©àdG §Ñ°†d iôNC’G π``jó©àdG äGhOCG ¢†©H ‘ É¡eGóîà``°SG øμÁh .áeó≤ŸG hCG á``«Ø∏î∏d

.á«©Lôe ká£≤f É¡JAÉ°VEG hCG É¡fƒd OÉªàY’ IQƒ°üdG øe áæ«©e á≤£æe ≈∏Y ô≤ædG ≥jôW øY ¿GƒdC’G

ø«©dG áMGQEG ™°Vh

 √òg ≥«≤– ¿EGh ,GÒ``eÉμdG QÉ``¶æe áe uó≤ oeh Q uƒ``°üŸG Ú``Y ÚH á``«dÉãŸG áaÉ``°ùŸG ≈``dEG Ò``°û oj í``∏£°üe

.øμ‡ Qób ÈcCÉH ó¡°ûŸG ≈dEG ô¶ædG Qƒ°üª∏d í«àj áaÉ°ùŸG

á«æ«©dG á©£≤dG πjó©J

.dioptric correction :IOÉe ô¶fG

Dictionary 1 column.indd   59Dictionary 1 column.indd   59 10/11/16   10:12 AM10/11/16   10:12 AM
JobNo.: DJB4422_TAMID KITAB KAMOUS
Book Name: 

Barcode/ISBN: 
JobCode: --

Operator:A_RAHIM
Sales Person:
Customer:

Date:16-11-20
Time:11:32:52

Page Position:59

File Name:INSIDE_20-11-2016.p59.pdf
Proc. Plan:02_A4_2side0f306cfd220fff49b89af38e08acaeb0

TrimSize:120 x 210
PageSet:ppageset1

Page colors:Black

o b e i k a n . com




